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AKVIS NATUREART 12.5 | BRING NATURE TO YOUR PHOTOS

It's hard to compete with nature in diversity and man has still much to learn from it. We are not able to create the Earth in
seven days, but we can imitate some of its natural phenomena in digital art.

AKVIS NatureArt is an excellent tool for imitating the magnificence of natural phenomena on your photos.

The software lets you apply weather effects to your picture or create nature scenes from scratch, converting a blank
background into a sea view or a night sky with scattered, glistening stars.

If a photo looks a bit lifeless and dull, you can add some dramatic effects by putting the shining sun or a marvelous rainbow,
or even a lightning bolt on it, and by adding rain or snow, or a misty fog.
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In fact, the same photo can look differently if we change the weather on it. The spirit of the scene changes dramatically -
from a ferocious thunderstorm to an optimistic shiny day, from the woods in flame to a melancholic rainy scene.

Nature effects have an impact on our mood and can be used to strengthen the impression made by a picture.
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The software offers 12 nature effects: Rain, Sun, Water, Lightning, Clouds, Frost, Rainbow, Aurora, Fire, Ice, Night
Sky, and Snow.

The premium effects (Fire, Ice, Night Sky, Snow) are only available for Home Deluxe and Business licenses. In the Home
version, these effects are applied with the AKVIS watermark.
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From 12 basic effects it's possible to create an even wider variety of natural phenomena: transform the sun into the moon,
get moss from frost, create clouds-based fog, and much more!
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With AKVIS NatureArt you can become a master of fire and lightning… You can become a wizard!

The effects in NatureArt are easy to add and adjust. Just select an area in the image and apply the effect.

You can also use the ready-to-use AKVIS Presets for each effect to get a quick result. They can be applied "as is" or can
be modified. You can save your favorite settings as a preset and use them in the future. It's possible to import/export users
presets and share them with other fans of the program.
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AKVIS NatureArt is available as an independent standalone program and as a plugin to a photo editor. The plugin version is
compatible with AliveColors, Adobe Photoshop, Corel PaintShop Pro, etc. Check the compatibility.

 

The functionality of the program depends on the license type. The Fire, Ice, Night Sky, and Snow effects as well as the
History Brush tool are only available under the Home Deluxe and Business licenses.

During the test period you can try all features and choose the license you like.
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INSTALLATION ON WINDOWS

Please find instructions below on how to install the AKVIS programs on Windows.

You must have administrator rights to install the program on your computer.

Before installing the AKVIS plugins, please make sure that the image editor where you want to install the plugins, is closed. Or
re-run the image editor after the installation of the plugin.

 

1. Run the setup exe file.
2. Select your language and press the Install button.
3. To continue the installation process you have to read and accept the End User License Agreement.

Activate the check box "I accept the terms in the License Agreement", and press Next.

4. To install the Plugin, select your photo editor(s) from the list.

To install the Standalone version, make sure that the corresponding option is activated. 
To create a shortcut for the program on desktop, activate Desktop Shortcut.

Press Next.

5. Press the Install button.
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6. The installation is in progress.

7. The installation is completed.

You can subscribe to the AKVIS Newsletter to be informed about updates, events, and special offers. Enter your e-
mail address and confirm that you accept the Privacy Policy.
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8. Press Finish.

After installation of the standalone version, you will see the program name in the Start menu and a shortcut on the
desktop, if during installation the corresponding option was enabled.

After installation of the plugin, you will see a new item in the Filter/Effects menu of your photo editor. For example in
Photoshop: Filter -> AKVIS –> NatureArt, in AliveColors: Effects -> AKVIS –> NatureArt.
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INSTALLATION ON MAC

Follow the instructions to install the AKVIS software on a Mac computer.

You must have administrator rights to install the program on your computer.

 

1. Open the dmg file:

- akvis-natureart-app.dmg to install the Standalone version

- akvis-natureart-plugin.dmg to install the Plugin into your image editor.

2. Read the License Agreement and press Agree, if you agree with the conditions.

3. Finder will open with AKVIS NatureArt application or AKVIS NatureArt PlugIn inside.

 

4. To install the Standalone version, drag the AKVIS NatureArt app into the folder Applications (or any other place you
like).

To install the Plugin, drag the entire AKVIS NatureArt PlugIn folder into the Plug-Ins folder of your graphic editor:

AliveColors: You can choose in the Preferences the folder of the plugins.

Photoshop CC 2023, CC 2022, CC 2021, CC 2020, CC 2019, CC 2018, CC 2017, CC 2015.5:
Library/Application Support/Adobe/Plug-Ins/CC;

Photoshop CC 2015: Applications/Adobe Photoshop CC 2015/Plug-ins;

Photoshop CS6: Applications/Adobe Photoshop CS6/Plug-ins.
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AKVIS Plugins on Mac
(click to enlarge)

After installation of the plugin, you will see a new item in the filters/effects menu of your photo editor. Select in Photoshop:
Filter -> AKVIS -> NatureArt, in AliveColors: Effects -> AKVIS -> NatureArt.

Run the standalone application by double-clicking on its icon in Finder.

You can also run the AKVIS programs from the Photos app by choosing the Image -> Edit With command (in High Sierra and
later versions of macOS).
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INSTALLATION ON LINUX

Follow the instructions to install the AKVIS software on a Linux computer.

Note: The AKVIS programs are compatible with Linux kernel 5.0+ 64-bit. You can find out the kernel version using
the uname -srm command.

 

Installation on Debian-based systems:

Note: You need apt-install or apt-get permissions required to install software.

1. Run the terminal.
2. Create a directory to store keys: 

sudo mkdir -p /usr/share/keyrings
3. Download the key that signed the repository: 

curl -fsSL https://akvis.com/akvis.gpg | sudo tee /usr/share/keyrings/akvis.gpg >/dev/null 
or wget -O - https://akvis.com/akvis.gpg | sudo tee /usr/share/keyrings/akvis.gpg >/dev/null

4. Add the repository to the list where the system looks for packages to install: 
echo 'deb [arch-=i386 signed-by=/usr/share/keyrings/akvis.gpg] https://akvis-
deb.sfo2.cdn.digitaloceanspaces.com akvis non-free' | sudo tee /etc/apt/sources.list.d/akvis.list

5. Update the list of known packages: 
sudo apt-get update

6. Install AKVIS NatureArt 
sudo apt-get install akvis-natureart

7. The installation is completed.

Launch the program via the terminal or using the program shortcut.

8. For automatic updates, use the command: 
sudo apt-get upgrade

To remove the program: 
sudo apt-get remove akvis-natureart --autoremove

 

Installation on RPM-based systems (CentOS, RHEL, Fedora):

1. Run the terminal.
2. Register the key that signed the repository: 

sudo rpm --import https://akvis.com/akvis.asc
3. Add the repository to the system: 

sudo wget -O /etc/yum.repos.d/akvis.repo https://akvis.com/akvis.repo
4. Update the package list:

when using the dnf package manager: 
sudo dnf update

when using the yum package manager: 
sudo yum update

5. Install AKVIS NatureArt:

when using the dnf package manager: 
sudo dnf install akvis-natureart

when using the yum package manager: 
sudo yum install akvis-natureart

6. The installation is completed.

Launch the program via the terminal or using the program shortcut.

7. For automatic updates:

when using the dnf package manager: 
sudo dnf upgrade

when using the yum package manager: 
sudo yum upgrade

8. To remove the program:

when using the dnf package manager: 
sudo dnf remove akvis-natureart

when using the yum package manager: 
sudo yum remove akvis-natureart
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Installation on openSUSE.

1. Run the terminal.
2. Login as a root user.
3. Add the key that signed the repository: 

rpm --import http://akvis.com/akvis.asc
4. Add the repository to the system: 

zypper ar -r https://akvis.com/akvis.repo akvis
5. Update the package list: 

zypper ref
6. Install AKVIS NatureArt: 

zypper install akvis-natureart
7. The installation is completed.

Launch the program via the terminal or using the program shortcut.

8. For automatic updates: 
zypper update

To remove the program: 
zypper remove akvis-natureart

 

In order to display the program interface correctly, it is recommended to install the Compton or Picom composite manager.

 

AKVIS NatureArt

15



AKVIS SOFTWARE ACTIVATION

Attention! During the activation process your computer must be connected to Internet.

If it is not possible, we offer you an alternative way (see below for Offline Activation).

 

Download AKVIS NatureArt and install the program. Read the Installation Instruction here.

When you run the unregistered version, a splash window will appear displaying general information about the version and the
number of days left in your trial period.

You can also open the About the Program window by pressing the button  in the program's Control Panel.

 

Click on TRY IT to evaluate the software. A new window will appear with variants of licenses to test.

You do not need to register the trial version to try all features of the software. Just use the program during the evaluation
time (10 days after the 1st start).

During the test period you can try all options and choose the license you like. Select one of the offered functionality types:
Home (Plugin or Standalone), Home Deluxe, or Business. Your choice of license will affect which features will be available
in the program. Consult the comparison table for more details about license types and versions of the software.

If the trial period has expired, the TRY IT button is disabled.

 

Click on BUY NOW to choose a license to order.

When the payment is effected, your serial number for the program will be sent to you within minutes.

 

Click on ACTIVATE to start the activation process.
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Enter your name (the program will be registered to this name).

Enter your serial number (your license key).

Choose the method of activation — either direct connection to the activation server or by e-mail.

Direct connection:

We recommend activating the program using direct connection, as it is the easiest way.

At this step your computer must be connected to Internet.

Press ACTIVATE.

Your registration is completed!

Request by e-mail:

In case you have chosen activation by e-mail, a message with all necessary information will be created by the program.

NOTE: You can also use this method for Offline Activation:

If your computer is not connected to Internet, transfer the activation message to a computer connected to Internet,
for example, with a USB stick. Send us this information to: activate@akvis.com.

Please do not send the screenshot! Just copy the text and save it.

We need your serial number for the software, your name, and HardwareID (HWID) of your computer.

We will generate your license file (NatureArt.lic) using this information and will send it to your e-mail address.

Save the .lic file (do not open it!) to your computer where you want to register the software, in the AKVIS folder in
Users’ Shared (Public) Documents:

Windows:

C:\Users\Public\Documents\AKVIS

(This PC > Local Disk (C:) > Users > Public > Documents > AKVIS)

Mac:

/Users/Shared/AKVIS

Open the Finder,  se l ec t  the  Go menu,  then se lec t  Go to Folder... (⌘ +Shift+G ) ,  t ype

"/Users/Shared/AKVIS", and click Go.

Linux:

/var/lib/AKVIS

Your registration is completed!
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When the program is registered, BUY NOW turns to UPGRADE that lets you improve your license (for example, change
Home to Home Deluxe or Business).
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WORKSPACE

AKVIS NatureArt can work independently as a standalone program or as a plugin to a photo editor.

Standalone is an independent program. You can run it in the usual way.
Plugin is an add-on for graphics editors, for example for Photoshop, AliveColors, and other compatible programs. To call
the plugin, select it from filters of your image editing program.

The AKVIS NatureArt workspace looks like this:

AKVIS NatureArt Workspace

 

Most of NatureArt's window is taken up by the Image Window with two tabs, Before and After. The original image is
displayed in the Before tab, and in the After tab, the image after processing. You can switch between the windows by
clicking on a tab with the left mouse button.

In the upper part of the program's window you can see the Control Panel with the following buttons:

The button  opens the home page of AKVIS NatureArt.

The button  (only in the standalone version) open the New Image dialog box. The hot-keys are Ctrl+N  on

Windows, ⌘ +N  on Mac.

The button  (only in the standalone version) opens an image for processing. The hot-keys for the command are

Ctrl+O  on Windows, ⌘ +O  on Mac.

It's possible also drag the required image into the workspace of the program. The program supports RAW, JPEG, TIFF,
PNG, BMP file formats.

The button  (only in the standalone version) saves image to the disk. The hot-keys are Ctrl+S  on Windows,

⌘ +S  on Mac.

The button  (only in the standalone version) opens the Print dialog to print the result. The hot-keys are Ctrl+P

on Windows, ⌘ +P  on Mac.

The button  imports a list of user presets (from the .natureart file).

The button  exports user presets. You can save any presets to a .natureart file.

The button  loads selected areas and direction lines saved to a .nature file.

The button  saves selected areas and direction lines to a .nature file.

The button  /  shows and hides a selection or support lines.

The button  cancels the last operation. It is possible to cancel several operations in a row. The hot-keys are

Ctrl+Z  on Windows, ⌘ +Z  on Mac.

The button  returns the last cancelled operation. It is possible to return several operations in a row. The hot-keys
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are Ctrl+Y  on Windows, ⌘ +Y  on Mac.

The button  starts processing the image. Use hot-keys: Ctrl+R  on Windows, ⌘ +R  on Mac.

The button  (only in the plugin version) applies the result and closes the plugin.

The button  calls information about the program.

The button  calls the Help files. The hot-key is F1 .

The button  calls the Preferences dialog box for changing the program's options.

The button  opens a window showing the latest news about NatureArt.

 

To the left of the Image Window is the Toolbar. The tools' parameters are shown in a pop-up box after right-clicking in the
image window.

 

Effect Area Tools:

Different tools appear depending on the Effect chosen.

 

Post-Processing Tools (available for Home Deluxe and Business licenses):

The button  activates the History Brush tool which restores areas to their original state.

Attention! The tool works in the After tab. If you switch to the Before tab and run the image processing again ,

the changes made with this tool will be lost.

 

Additional Tools:

The button  activates the Hand tool which allows you to scroll the image when it does not fit within Image

Window at the desired scale. To use it, click the button, bring the cursor over the image, and while keeping the left
mouse button pressed move in the desired direction. 
Double-clicking on the tool's icon  on the Toolbar makes the image fit the Image Window.

The button  activates the Zoom tool, which changes the image's scale. To zoom in, left-click in the image. To zoom

out, left-click with Alt  in the image. Press Z  to quickly access the tool.

Double-clicking on the tool's icon  on the Toolbar makes the image scale to 100% (actual size).

 

Navigate and scale the image using the Navigator. The frame in the Navigator surrounds the area of the image which is
visible in the Image Window; the area outside of the frame will be shaded. The frame can be dragged, thereby changing the
visible portion of the image. To move the frame, place the cursor within it, left click the mouse, and then drag.

In addition, you can move the image in the Image Window using the scroll bar or by holding down the space bar, and then
holding down the left mouse button while moving the mouse. The mouse's scroll wheel can move the image up and down,
while holding Ctrl  on Windows, ⌘  on Mac – while moving the scroll wheel will move the image left and right. Holding Alt  on

Windows, Option  on Mac will scale the image. Right-click the scroll bar to activate the quick navigation menu.

Use the slider to scale the image in the Image Window. When you move the slider to the right, the image scale increases.
When you move the slider to the left, the image scale reduces.

You can also change the image scale by entering a new coefficient into the scale field. The fall-down menu shows some
frequently used coefficients.

You can use hot-keys to change the image scale +  and Ctrl++  on Windows, ⌘ ++  on Mac to increase the image scale
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and -  and Ctrl+-  on Windows, ⌘ +-  on Mac to reduce the scale.

 

Below the Navigator is the Settings Panel where you can choose the Effect. Each effect contains its list of Presets and
customizable parameters.

Under the settings, you can see Hints for the parameters and buttons when you hover over them with the cursor.

 

AKVIS NatureArt

21



USING THE PROGRAM

AKVIS NatureArt miraculously adds natural phenomena to your photos. It lets you transform images and make new ones
creating nature scenes from scratch. The software can work independently as a standalone application and as a plugin with a
compatible graphics editor.

Follow these instructions to add a natural effect to an image:

Step 1. Load an image into the software.

- If you work with the standalone version:

To load an image, you can double-click within the empty window, drag the image into the program workspace, or
use the button . The program supports JPEG, RAW, PNG, BMP, TIFF, and WEBP file formats.

- If you work with the plugin:

Open an image in your photo editor by calling the command File -> Open or using the key combination Ctrl+O

on Windows, ⌘ +O  on Mac.

Then call the AKVIS NatureArt plugin in the Filter/Effects menu of the photo editor:

in AliveColors: Effects -> AKVIS -> NatureArt; 
in Adobe Photoshop: Filter –> AKVIS –> NatureArt; 
in Corel Paint Shop Pro: Effects –> Plugins -> AKVIS –> NatureArt.

Original Photo

Step 2. Choose an Effect in the Settings Panel. The program offers these nature effects: Rain, Sun, Water,
Lightning, Clouds, Frost, Rainbow, Aurora, Fire, Ice, Night Sky, and Snow.

Note: The Aurora, Fire, Ice, Night Sky, and Snow effects are only available for Home Deluxe and Business
licenses. In the Home version, these effects are applied with the AKVIS watermark.

Step 3. Select areas where an effect will be applied. Each effect has its own tools for this task.

Hint: You can change the tool's size in a pop-up window which opens with a right mouse click in the image. To
draw a straight line use the Shift -key.

Direction Lines
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You can choose how the selection looks like in the program Preferences .

It's possible to change the size and position of the selection with the Transform tool .

Hold down the Shift  key to maintain the object's proportions. Hold down Alt  to rotate the object by 5 degrees

intervals or to scale it from its center.

Transforming Selection

You can save the selection or direction lines to a .nature file with  and load with .

Step 4. Start processing with .

Hint: Enable the Autorun Mode in the Settings Panel to apply any changes automatically. It is helpful when
selecting the presets or adjusting the effect parameters. 
If the option is disabled, you need to press  in order to see the changes applied.

The image will be processed, and the result will be shown in the After tab.

Default Settings for Lightning Effect

Step 5. If you want other results change the effect's parameters in the Settings Panel.
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Lightning Effect Using the History Brush

Adjusting Settings

Step 6. You can also make final touches and correct the result using the post-processing tool which - History Brush 
 on the After tab. This tool is available only under the Home Deluxe and Business licenses! It lets you change the

area and the intensity of the applied effect, fade the effect and restore the image to its original state.

Attention! If you switch to the Before tab and run processing with , the changes made with the History

Brush will be lost.

You can adjust the parameters for the tool in the pop-up box that appears after a right click in the image window:

- Brush Size (1-1000) changes the tool's diameter.

- Hardness (0-100%) defines the blurriness of the tool's edges. The less the value the more blurry the edges of
the brush are.

- Strength (1-100%) affects the degree of restoration to the original state.

Step 7. It is possible to save the settings you like as a preset and use them in the future.

Learn more about the NatureArt Presets.

Step 8. In the standalone program, you can print your image with .

Step 9. Save the processed image.

- If you work with the standalone edition:
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Click  to open the Save As dialog box. Enter a name for the file, choose the format (TIFF, BMP, JPEG PNG,

or WEBP) and indicate the target folder.

- If you work with the plugin:

Press the button  to apply the result and close the plugin window. The AKVIS NatureArt plugin will close and

the resized image will appear in the workspace of the photo editor.

Call the Save As dialog box using the command File -> Save As, enter a name for the file, choose the format
and indicate the target folder.

Result (click to open in large size)
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WORKING WITH PRESETS

AKVIS NatureArt includes a number of ready to use Presets which help you start working. They can be applied "as is" or
can be modified.

All tabs of settings have the common list of presets. When a new preset is created it will be available in all tabs and will
contain their settings.

To create a preset, adjust the settings, type a name for the preset into the field, and press Save.

To return to the default settings of the selected preset, press Reset.

To delete a preset, choose it from the drop-down list and press Delete.

The AKVIS built-in presets cannot be removed.

You can save your presets to a .natureart file with . To load presets from the file use .

Read more how to import and export user presets.
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Sun and Clouds Effects

 

Rain, Fire, Lightning Effects

TIPS & TRICKS FOR WORKING WITH AKVIS NATUREART

These tricks will help you create various nature effects using AKVIS NatureArt.

 

Autorun Mode. When selecting the presets or adjusting the parameters, it is recommended to enable this mode. This
considerably speeds up the time needed for the processing.
When working with tools (regardless of the effect), it's better to disable the Autorun Mode.

 

Take advantage of ready-to-use presets. For your convenience the program offers a number of ready-to-use
presets. By using the presets, you can quickly select effect settings.

 

Save the selections and direction lines! For this purpose just press the button . By clicking on  you can

load the saved file to make a change (for example, to add or remove something). See an example of working with saved
direction lines.

 

It's possible to apply multiple effects to an image.

 

Source Image

In the standalone version save the result with  and then choose Yes when asked the question: Use the result as

a source image?

If you want to get different images with various effects applied, select No.
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Water Effect

 

Rainbow Effect

In the plugin version just re-call the NatureArt filter and apply the effect you want with .

 

To draw a straight line with the Selection Brush , click once where you want the line to start, move to the other

end of the line, and hold down the Shift  key.

You can lock the mouse movement to either horizontal or vertical direction by holding the Shift  key.

 

To cancel the selection, use the Selection Bucket  in the "eraser mode". Just click with the tool while pressing

Ctrl .

 

You can choose how the selection appears in the program Preferences : "marching ants" or filled with color (by

default, red), and change the opacity of the color.

 

To reduce the effect and correct the result, use the History Brush . Read more…

Note that this tool is only available for the Home Deluxe and Business licenses.

 

To change the image scale you can use the following keyboard shortcuts: +  and Ctrl++  on Windows, ⌘ ++  on

Mac to increase the image scale; -  and Ctrl+-  on Windows, ⌘ +-  on Mac to reduce the scale.

Double-clicking on the tool's icon  makes the image scale to 100%. Double-clicking on the tool's icon  makes the

image fit the window.

 

To cancel the last operation use the hot-key Ctrl+Z  on Windows, ⌘ +Z  on Mac or click .

To return the last cancelled operation use the hot-key Ctrl+Y  on Windows, ⌘ +Y  on Mac or click .

 

Adjust the tools' parameters in the pop-up window that appears when right clicking in the image.
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Pay attention to your license type. The functionality of the program depends on the license type. Consult the
comparison table for more information. During the test period you can try all options and choose the license you like.
You can upgrade your Home license to Home Deluxe or Business anytime by paying the difference in prices.
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PREFERENCES

Open the Preferences dialog by pressing on . The dialog window looks like this:

Language. Choose the program language in the drop-down list.
Interface Scale. Choose the size of the interface elements. When it is set to Auto, the program workspace will
automatically scale to fit the screen resolution.
Interface Theme. Select the style of the program interface: Light or Dark.
Initial Image Scale. This parameter defines the way the image is scaled in the main window after loading:

- Fit to View. The scale adjusts so that the image will be completely visible;

- 100%. The actual size is used, the image doesn't scale.

Recent Files (only in the standalone version). The number of recent documents. The list of the recent files, sorted by
time, become visible by right mouse clicking on . Maximum: 30 files.

History States (5-100). The size of the memory stack. It limits the number of the undo/redo steps (  and ).

Selection Area. This parameter defines how the selection appears (not valid for the Night Sky effect). Please choose
one of two variants:

- "Marching Ants". The selection is enclosed in borders that look like a "running" dashed line. This is the default
value.

- Filled with Color. The selection will be filled with a color.

By default, it is red. You can change it by double-clicking on the color plate.

The Opacity parameter allows you to adjust the opacity of the color used to highlight the selection.
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"Marching Ants"

 

Filled with Color

Hints Panel. When you hover over parameters and buttons with the cursor you can see a brief description of them in
the Hints field. You can choose how the hints will be shown:

- Under Image Window;
- Under Settings Panel;
- Hide.

Lock the Control Panel check-box. It disables the possibility to hide/show the top panel. If the check-box is selected
the panel is always visible.

To apply changes made in the Preferences window press OK.

If necessary, you can return to the default settings by pressing Default.
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PRINT IMAGES IN AKVIS NATUREART

In the standalone version of AKVIS NatureArt you can print the image. Press the button  to open the Print options.

Print Options in AKVIS NatureArt

Adjust the parameters appearing in the Settings Panel:

Choose a printer from the list of available devices, set the desired resolution, as well as the number of copies to print.

In the Orientation group, set the position of paper: Portrait (vertically) or Landscape (horizontally).

Click the Page Setup button to open a dialog box to choose the size of the paper and its orientation, as well as the
print margins.

Press the Reset Margins button to return the page margins to the default size.

Change the size of the printed image adjusting the parameters Scale, Width, Height and Fit to Page. These
parameters have no effect on the image itself, just on the print version. You can change the size of the printed image
by entering any value in %, or by entering new values in Width and Height.

To adjust the size of the image to the paper size, select Fit to Page.

Move the image on the page with the mouse or align it using the arrow buttons.

You can activate Frame for the image and adjust its width and color.

Choose the Background Color by clicking on the color plate.

In the Page tab, you can adjust printing of the multiple copies of the image on a single sheet.
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Print Page

Copies per Page. It lets you specify the number of copies of the image on one page.
Horizontally and Vertically. These parameters indicate the number of rows and columns for the copies of the
image on the page.
Spacing. The parameter sets the margins between the copies of the image.

In the Poster tab, it's possible to customize printing of the image on multiple pages for the subsequent junction into a
large picture.

Print Poster

Pages. If the check-box is enabled, you can specify the maximum number of the pages in which the image will be
divided. The image scale will be adjusted to fit this number of the sheets. If the check-box is disabled, the
program will automatically select the optimal number of the pages in accordance with the actual size of the image
(scale = 100%).
Glue Margins. If the check-box is enabled, you can adjust the width of the padding for bonding sheets. Margins
will be added to the right and to the bottom of each part.
Show Numbers. With the enabled check-box, a sequence number of each part, by a column and a row, will be
printed in the margins.
Lines of Cut. Activate the check-box to display the cut marks in the margins.

To print the image with the chosen parameters, press the Print button. 
To cancel and close the printing options click on Cancel.

Click the Properties... button to open a system dialog box that enables you to access the advanced settings and send the
document to print.
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Density = 5

 

Density = 15

NATURE EFFECTS: RAIN

This effect is used to add raindrops to an image: basically, different types of rain (from drizzle to downpour), and by adjusting
some parameters even snow (AKVIS Snow preset).

Rain Effect in AKVIS NatureArt

The effect will be applied only in a selected area! Use the follow tools to make a selection:

Selection Brush . This tool is used to highlight areas to which an effect will be applied. You can change the tool's

size in a pop-up window which opens with a right mouse click in the image window.

To get a straight line, draw a line while holding down Shift .

Eraser . Use this tool to erase selection areas. You can change the tool's size in a pop-up window.

Selection Bucket . The tool fills an area outlined with the Selection Brush  (helpful for selecting large areas).

If the area was not circled by , the entire image will be selected by clicking with .

Hint: You can use Selection Bucket in "eraser mode" to erase all selections at the image. Just click the left
mouse button while pressing Ctrl .

 

In Settings Panel you can adjust the parameters for the Rain effect:

Density (0-20). This parameter sets the density of the rainfall. At lower values the effect appears as drizzle, the
raindrops are sparse and are far from each other. At higher values is is similar to a "wall" of rain.
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Length = 10

 

Length = 40

 

Scale = 1

 

Scale = 3

 

Angle = 90
Length = 10

 

Angle = 60
Length = 15

 

Angle = 135
Length = 25

Length (0-100). This parameter defines the degree to which drops are lengthened. It also acts as a constraint on
length. The length of drops may be different, but their length will not exceed the specified value.

Scale (0.10-10.00). This parameter affects the size of raindrops. If Length is changed the raindrops will only change in
length, but changing this parameter affects the size of raindrops in all geometric directions. The higher the value, the
larger the raindrops.

Angle (0-180). This parameter determines the direction of falling raindrops and leads to the creation of another effect
- wind. If the value is equal 90, rain falls vertically (no wind). At values less than 90 the rain falls at a right angle (wind
is blowing from right to left). At values higher than 90 it falls at a left angle (wind is blowing from left to right).

Note: If you watch through a window at how rain falls, it's clear to see that wind deforms raindrops: smearing
them on the glass, stretching them. It does the same thing in the air. Therefore, to achieve the most realistic
effect it is necesssary to change both the Angle and Length of the raindrops. The greater the slope, determined
by Angle, the stronger the force of the wind and the stronger the effect of Length.

Dispersion (0-90). This parameter determines the deviation of raindrops from the general direction of rainfall (which is
based on Angle). When the value is set to 0 all raindrops fall at the same angle. At higher values raindrops will deviate
from the direction specified by Angle. The higher the value, the greater the deviation of the raindrops' pattern.

The value of "Dispersion" has been set to 0
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Dispersion = 0

 

Dispersion = 15

 

Dispersion = 35

 

Transparency = 5%

 

Transparency = 40%

The value of "Angle" has been set to 90
 

Transparency (0-100). This parameter affects the translucency of raindrops. At higher values, their color fades and
more of the image is visible through them.
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NATURE EFFECTS: SUN

This effect adds the most important celestial body to an image - The Sun in all of its manifestations, depending on the time
of day, the seasons, and the weather: bright, dim, summer, winter, rising, setting, etc. By changing settings or using one of
the presets from AKVIS, it's possible to transform the sun into the moon (AKVIS Moon preset) or another more distant star
(AKVIS Star preset).

 
Sun Effect in AKVIS NatureArt

 

Use the Transform  tool in the Before tab to determine the location of the sun, its size, and the direction of its rays.

The sun is depicted schematically as a circle with rays emanating from it (the number of which is determined by the
corresponding parameter in the Rays tab). When  is pressed, markers appear around the circumference of the frame.

To move an object, bring the cursor within the frame, after which it will take the form of double perpendicular arrows, left
click the mouse and while holding it down, drag the cursor. You can also draw a sun anywhere on the image by double clicking
the left mouse button.

Note: To correctly place the sun and achieve the most realistic result, consider the location of shadows in the image.
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Original Position

 
Position After Moving

To change the size of the sun, bring the cursor within the frame so that it takes the form of a double-headed arrow, and
after clicking and holding the left mouse button, move the cursor to increase or decrease it.

Changing the Size of the Sun

The sun's rays can be rotated. To rotate them, bring the cursor outside of the frame, so that it takes the form of a rounded
double-headed arrow, and after clicking and holding the left mouse button, drag the cursor.

Changing Position of the Rays

 

Configure the effect's settings.

You can adjust the parameters for the Sun effect in the Settings Panel. There are two tabs: Sun and Rays.

Sun Tab:

Working with color. There are three color to set for the sun: Sun Color, Glow Color and, if desired, Additional Glow
Color. Usually two colors are enough. In rare cases an additional color is required, mainly for a rising or setting sun.

Click on the color plate and select a color in the standard dialog.
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Sun - White, Glow - Yellow
Additional Glow deactivated

 

Sun - White, Glow - Yellow
Additional Glow - Orange

 

Power = 0.50

 

Power = 0.85

 

Smoothness = 2

 

Smoothness = 20

Power (0.30-1.00). This parameter determines the size of the sun's glow and its intensity. At higher values the glow is
stronger and covers a larger area.

Smoothness (0-25). This parameter determines how smooth the transition between the colors of the sun and its glow
will be. Increasing the value of this parameter will make the transition between colors smoother.

 

Rays Tab:

Enable Rays check-box. When this option is enabled, the rays are drawn accordingly to the settings described below.
If you want a sun without rays, turn this option off. In this case the parameters in this tab will not be active.
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The "Random Distribution" check-box is disabled

 

The "Random Distribution" check-box is enabled

 

Number = 5

 

Number = 11

 

Max Length = 20

 

Max Length = 100

 

The "Enable Rays" check-box is disabled

Random Distribution check-box. If the check-box is enabled, the rays are placed randomly. If the option is disabled,
the rays are arranged symmetrically at the same distance between them.

Number (1-100). The parameter determines the number of the rays.

Max Length (0-200). The parameter controls how far the rays spread, and also acts as a contraint on their length.
The length of the rays can be different but they will be no longer than the specified value.

Smoothness (1-100). The parameter changes blurriness of the outer edge of the rays. The higher the value, the
smoother the edges are.
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Smoothness = 1

 

Smoothness = 95

 

Width = 25

 

Width = 60

 

Transparency = 30%

 

Transparency = 80%

Width (1-100). The parameter changes the width and brightness of the rays.

Transparency (0-99%). The parameter determines the translucency of rays. At higher values their color fades and
more of the image is visible through them. For a more realistic effect it is best to set this to a high value.
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NATURE EFFECTS: WATER

This effect can be used to add a body of water to an image.

 
Water Effect in AKVIS NatureArt

 

Before you adjust the parameters for this effect, use the Move tool  to set the height of the expected horizon.

 
Set the horizon line

Below the horizon will be water, and above it, the remainder of the image. The horizon can be moved vertically up or down to
any level.

Adjust the parameters for the Water effect. The parameters for this effect are divided in two tabs: Waves and Glare.

 

Waves Tab. Under this tab are parameters which define the basic characteristics of water.

Density (0-20). This parameter determines the number of waves per unit area at their regular size. The higher the
value, the closer the waves will be to each other and and the number of them will increase.
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Density = 5

 

Density = 15

 

Height = 20

 

Height = 40

 

Length = 40

 

Length = 70

Height (1-100). This parameter determines the size of a wave in the vertical direction. The higher the value the higher
the wave.

Length (1-100). This parameter determines the size of a wave in the horizontal direction. The higher the value, the
longer the wave.
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Direction = 60

 

Direction = 120

 

Dispersal = 20

 

Dispersal = 80

 

Depth = 20

 

Depth = 60

 

Ripples = 0

 

Ripples = 30

Direction (0-180). This parameter determines the direction of the flow of waves. At a value of 0, the waves are
perpendicular to the flow of water. As the value increases, the waves will move clockwise.

Dispersal (0-90). This parameter determines the difference between the direction of waves. When the value is set to
0, all waves follow the same direction. As the value increases, individual waves deviate from the direction specified by
Direction. The higher the value, the greater the deviation.

Depth (0-100). By adjusting this parameter you can change the visual perception of the water's depth. The higher the
value, the darker the water and the greater its depth.

Ripples (0-100). This parameter adds an additional relief effect to the waves and determines the degree to the effect.
The higher the value, the more ribbed and embossed the waves will be.

Color. Use this parameter to change the the water's color and select the appropriate color based on the type of body
of water. To change the color, click on the color plate and choose a color from the Select Color dialog.

AKVIS NatureArt

44



 

Brightness = 50

 

Brightness = 90

 

Horizontal Shift = 70

 

Horizontal Shift = 110

Change color of the water

 

Glare Tab. If the original photo has a light source, then when you add water light should be reflected in it, creating a glare.
The parameters under this tab define the characteristics of the solar glare.

Brightness (0-99). This parameter defines the brightness of a solar glare. The higher the value, the brighter the glare
on the water.

Note: If the value of the parameter is 0, there is no glare.

 

These parameters affect the location of the glare on the water:

Horizontal Shift (0-180). This parameter controls the horizontal position of the glare. If the value is set to 90, the sun
is above the center. At values greater than 90 it is located to the right, and at values less than 90 percent, to the left.

Vertical Shift (0-90). This parameter controls the vertical position of the glare. The higher the value, the more distant
the glare will be on the horizon, and the higher its position will be relatively to the camera.
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Vertical Shift = 75

 

Vertical Shift = 85

Note: These parameters only have an effect if Brightness for a glare is not set to zero.

If you wish to add a glare, pay attention to the lighting as well as the time of day in the photograph. As we
know, the sun is lower in the sky during the morning and evening than during the day.

Therefore, for photographs taken during the day, the glare should be closer to the camera (a lower value for
Vertical Shift), and for one shot in the morning or evening, closer to the horizon (a higher value for Vertical
Shift).
Similarly, the value for Horizontal Shift can be changed, depending on the position of the light source in the
original photograph.

Color. This parameter determines the color the solar glare. To change the color, click on the color plate and choose a
color from the Select Color dialog.

 

Orange glare selected
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NATURE EFFECTS: LIGHTNING

This effect can be used to add Lightning of any size and number to an image.

Usually lightning appears during a thunderstorm. It often gives us an unforgettable light show in the sky! What is this amazing
phenomenon of nature, beautiful and devastating at the same time?

Ancient people perceived the thunder and the lightning flashes as an expression of the will of the Gods and the manifestation
of God's wrath. Only in the 18th century was it proved that lightning is an electric discharge in the atmosphere accompanied
by a flash of light and the rumble of thunder. There are various types of lightning, but usually we see streak lightning or
forked lightning.

 
Lightning Effect in AKVIS NatureArt

Before applying this effect, you need to draw a "skeleton" where the lightning will be, to act as a schematic for it. Do this in
the Before tab with the following tools:

Direction . Use this tool to draw lines over which lightning will be drawn. To set a line, click anywhere on the image,

and while holding down the button, draw a line in any direction.
Eraser . Use this tool to delete unwanted parts of lightning. Any lines whose starting points are within the zone of

the tool will be erased. This zone is determined by the size of the eraser. You can change the size of the eraser by
right-clicking anywhere in the image and making an adjustment in the pop-up window.

The Line Set drop-down list in the Setting Panel contains ready-to-use lightning layouts which come bundled with the
program. When editing a sample its name is changed to Custom. To remove all the lines from the image, select Clear All.
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Thickness = 30

 

Thickness = 80

 

Curvature = 15

 

Curvature = 75

 
Draw the Direction Lines

Adjust the parameters to specify the settings for the lightning. The settings will apply to all of the lightnings on an image. If
you want to get various lightnings, save the result and restart the effect.

Main Bolt:

Thickness (1-100). This parameter controls the thickness of all lines which make up the lightning bolt. The higher the
value, the thicker and brighter the lines are.

Curvature (0-100). The lightning will be drawn as a curve. This parameter regulates the degree of curvature of the
main line of lightning. The higher the value, the more the bolt will be curved.

Color. Use this parameter to change the color of the lightning. To change the color, click on the color plate and choose
a different color from the Select Color dialog.
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Brightness Deactivated

 

Brightness Activated

 

Branching = 5

 

Branching = 80

Changing the Color of the Lightning

Brightness check-box. If the check-box is disabled, the program draws the lightning only with the selected color. If the
option is enabled, the lightning blends with background colors and becomes brighter giving an impressively luminous
effect.

 

Branches:

Branching (1-100). This parameter determines the branching of lightning. The higher the value, the more branches will
come from the main bolt of lightning.

Branch Curvature (0-100). This parameter regulates the degree to which branches of lightning bend. The higher the
value, the more curved the kinks forming a branch become.
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Branch Curvature = 15

 

Branch Curvature = 65

 

Distribution = 20

 

Distribution = 80

 

Glow = 10

 

Glow = 35

Distribution (1-100). This parameter controls the distribution of the lightning's branches. The higher the value, the
greater the distance over which branches will be distributed, and the larger the area they will occupy.

 

Glow:

Strength (0-40). This parameter controls the intensity of the glow. The higher the value, the stronger the glow is. At a
value of 0 the glow is absent.

Dispersal (0-40). At low values the glow is concentrated along the main line. The higher the value, the wider the glow
spreads. At high values the glow has less contrast.
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Dispersal = 10

 

Dispersal = 25

 

Brightness Deactivated

 

Brightness Activated

Color. Change the color of the glow in the Select Color dialog. Click on the color plate and choose a different color. By
default, the glow color is not selected and is equal to the color of the main lightning bolt. To reset a color, right-click on
the color plate.

Changing the Color of the Glow

Brightness check-box. If the check-box is disabled, the program uses only the selected color to draw the glow. If the
option is enabled, the glow blends with background colors and becomes brighter giving an impressively luminous effect.

Random Seed. This is the starting number for the random number generator that defines the form of the lightning.
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Generating Versions of Lightning
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NATURE EFFECTS: CLOUDS

This effect adds clouds to an image.

 
Clouds Effect in AKVIS NatureArt

The effect will be applied only in a selected area! Use the follow tools to make a selection:

Selection Brush . This tool is used to highlight areas to which an effect will be applied. You can change the tool's

size in a pop-up window which opens with a right mouse click in the image window.

To get a straight line, draw a line while holding down Shift .

Eraser . Use this tool to erase selection areas. You can change the tool's size in a pop-up window.

Selection Bucket . The tool fills an area outlined with the Selection Brush  (helpful for selecting large areas).

If the area was not circled by , the entire image will be selected by clicking with .

Hint: You can use Selection Bucket in "eraser mode" to erase all selections at the image. Just click the left
mouse button while pressing Ctrl .

 

In Settings Panel you can adjust the parameters for the Clouds effect:

Size (1-100). This parameter sets the size of the elements which make up clouds. As the value increases, these
elements will become larger.
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Size = 20

 

Size = 60

 

Cloudiness = 2

 

Cloudiness = 7

 

Density = 10

 

Density = 70

Cloudiness (1-20). This parameter sets the degree of cloudiness. The higher the value, the greater the accumulation
of clouds in the same area of the image.

Density (1-100). This parameter adjusts the density of the clouds. The higher the value, the denser and brighter the
clouds will look.

Transparency (0-100). This parameter affects the transparency of clouds. As the value increases, the clouds become
paler in color and more of the image is visible through them.
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Transparency = 30%

 

Transparency = 70%

 

Smoothness = 10

 

Smoothness = 40

 

Boundary = 2

 

Boundary = 20

Smoothness (0-50). This parameter affects the appearance of cloud edges. Changing this parameter changes the
contrast between neighboring pixels, making the clouds look sharper or softer. Increasing the value makes clouds
appear more blurred. At high values the clouds will look like fog.

Boundary (0-30). It has influence only at the selection borders. At mininum values, the selection border is an accurate
determinant of where cloud generation ends. Clouds which are not located within the selected area are cut off
lengthwise at its boundaries. As the value increases, the edge of where clouds will be generated moves inward, away
from the boundary of the selected area. Clouds cannot reach this boundary but at the same time may fall just beyond
it.

Low values are useful in situations where the sky is seen through various objects: a window, an arch, etc, or for
example, in situations when people are in the foreground.

Color. Use this parameter to change the color of the clouds. To change the color, click on the color plate and choose a
different color from the Select Color dialog.
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Changing the Color of the Clouds
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NATURE EFFECTS: FROST

This effect allows you to adorn an image with an openwork of frost crystals. In nature frost appears on long thin objects
during freezing weather. This gives an environment a fantastic look, sometimes almost surreal. Now you can add this beauty
to your digital photos easily.

 
Frost on Eyelashes

The effect will be applied only in a selected area! Use the follow tools to make a selection:

Selection Brush . This tool is used to highlight areas to which an effect will be applied. You can change the tool's

size in a pop-up window which opens with a right mouse click in the image window.

To get a straight line, draw a line while holding down Shift .

Eraser . Use this tool to erase selection areas. You can change the tool's size in a pop-up window.

Selection Bucket . The tool fills an area outlined with the Selection Brush  (helpful for selecting large areas).

If the area was not circled by , the entire image will be selected by clicking with .

Hint: You can use Selection Bucket in "eraser mode" to erase all selections at the image. Just click the left
mouse button while pressing Ctrl .

 

The effect's parameters can be adjusted in the Settings Panel.

Parameters under Pattern affect how the frost will be formed:

Expansion (0-100). The parameter influences how far the effect extends beyond the selection.
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Expansion = 20

 

Expansion = 70

 

Fill = 15

 

Fill = 90

 

Branching = 5

 

Branching = 88

Fill (0-100). The parameter affects the pattern's density within a selection. The higher the value of this parameter the
more dense the frost crystals are.

Branching (1-100). The parameter affects the intensity of branching along the selection. As this parameter's value is
increased the complexity, number, and length of branches increases.

Parameters under Ice do not affect the shape of the pattern and are only responsible for the ice's appearance:

Freezing (0-100). This parameter sets the freezing intensity of ice crystals. At lower values the edges of the frost are
thin and soft, while at the maximum value the ice becomes more homogeneous, dense, and solid.
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Freezing = 0

 

Freezing = 100

 

Transparency = 0

 

Transparency = 75

 

Shadow = 0

 

Shadow = 100

 

Uniformity = 10

 

Uniformity = 90

Transparency (0-100). The parameter affects the opacity of the ice in relation to the background color. At the
minimum value the ice is completely opaque; at higher values the background begins to be visible through the ice; and
at 100% it becomes a transparent layer of ice.

Shadow (0-100). The parameter adds a shadow to the ice pattern edges increasing the depth and clarity of the
pattern. At a value of 0 there is no shadow. The larger the value, the more visible outlines are.

Uniformity (0-100). The parameter affects the range of shades of the color of the ice. The higher the value, the more
uniform the color becomes, and the fewer shades are used.
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White

 

Lavender

Color can be changed by clicking on the color plate and choosing a new color from the Select Color dialog.

 

AKVIS NatureArt

60



NATURE EFFECTS: RAINBOW

A rainbow is a natural phenomenon that leaves no one indifferent. If you stand between the sun and the raindrops (with your
back to the sun), you will see an enormous colorful arc filling the sky, created by light refracted and reflected by billions of
raindrops. The colors of the rainbow always appear in the same order, from red to violet, and each color is paler than the one
before it. Droplets of mist over a body of water or a fountain can also create a rainbow.

 
Rainbow Effect in AKVIS NatureArt

The shape, size, and location of the rainbow are set by a semicircular frame which appears when the Transform tool  is

active.

By dragging any of the frame's three control points, you can adjust the arc's height and angle of curvature. When the cursor
is brought near one of the control points, it changes to a round shape : in this state, it is used to rotate the arc

clockwise or counterclockwise. If the cursor is brought within the frame it changes to this  shape, and the rainbow can be

moved steadily in one direction.
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Rainbow In Front Of Girl

 
Excluded Area

 
Rainbow Behind Girl

 
Changing the Shape of the Rainbow

You can use the Exclusion Tool  to select the areas that should be excluded from  ​​the effect. The tool protects the

selected areas keeping their initial state. It lets you hide parts of the rainbow on the image, for example, to make an object
appear to be "in front" of the rainbow.

You can adjust these parameters for the tool:

- Brush Size (1-500) affects the tool's diameter.
- Hardness (0-100%) defines the blurriness of the tool's edges. The less the value the more blurry the tool's edges
become.
- Strength (1-100%) adjusts the influence of the tool to the rainbow.

The Eraser tool  lets you edit the excluded area.

Hint: This effect can also be achieved with the History Brush  which restores areas to their original state.

 

The parameters for this effect can be adjusted in the Settings Panel.

Width (3-300). The parameter affects the lateral size of the arc.
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Width = 20

 

Width = 100

 

Transparency = 30

 

Transparency = 90

 

Normal Order of Colors
(the check-box is disabled)

 

Reversed Order of Colors
(the check-box is enabled)

Transparency (0-100). The parameter affects the opacity of the rainbow in relation to the background color. The
higher the value, the paler the rainbow appears.

Reverse Colors сheck-box. When the check-box is enabled, the order of colors of the rainbow is reversed.
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Rainbow

 

Fogbow

 

Noise Size = 5

 

Noise Size= 35

 

Noise Intensity = 0

 

Noise Intensity = 40

Fogbow. This check-box activates a group of parameters which are used to create a white rainbow. A white rainbow
appears when fog droplets, which are smaller than rainbow water drops, reflect light. This phenomenon is also called
seadog. The fog texture is created by adding noise.

You can adjust these parameters of the fogbow:

Noise Size (1-40). It defines the size of the noise spots (from small to large).

Noise Intensity (0-50). The parameter adjusts the depth and intensity of the noise. At the value = 0, no noise is
applied.

AKVIS NatureArt

64



 

Coloration = 0

 

Coloration = 15

Coloration (0-20). The parameter lets you add slight color to the fogbow. At the value = 0, the fogbow appears
completely colorless creating a white rainbow.
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NATURE EFFECTS: AURORA

Aurora borealis is a luminescence in the atmosphere. In ancient times flashes of cold fire were considered as words of gods,
their fiery dance in the northern sky. The scientific explanation of appearing of these beautiful lights relates to the solar wind
and Earth's magnetic field.

The aurora has different visual forms - stripes, rays, arcs, and twists through which we can see the stars. This atmospheric
phenomenon, similar to long colorful curtains in the sky, may extend for thousands of kilometers from west to east. The lower
edge of the aurora is usually sharp and clear, while the top edge is blurred. We always enjoy these spectacular shining views,
continuously and rapidly changing, with the rich color spectrum.

 
Aurora Effect in AKVIS NatureArt

To define the location of the effect use the tools:

Direction . Draw with the tool one or more base lines to choose the lower edge of the aurora. It's possible to

rotate and move the lines, changing the position of the effect, with the Transform tool .

Eraser . Click with the tool on any part of the line to remove it. You can change the tool's size in a pop-up window

appearing with a right mouse click on the image.

 

Base Lines and Effect Area
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Red, Green and Blue Aurora

 

Green and Blue Aurora

Various Forms of the Aurora (with Deformation = 45)

 

Adjust the effect parameters in the Settings Panel:

Colors. The color line with two sliders allows you to set colors of the aurora. The left edge of the line is responsible for
the colors at the bottom of the glow, right - for the colors at the top.

Reverse Colors. The check-box reverses the order of colors.
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Normal Order of Colors

 

Reversed Order of Colors

 

Normal Mode

 

Plus Mode

 

Color Blending = 7

 

Color Blending = 90

 

Lightness = 0

 

Lightness = 90

Blend Mode. In the drop-down list, you can specify a method of mixing the image with the effect. The program
provides 10 blend modes.

Glow Tab:

Color Blending (0-100). The parameter changes the level of color blending. At low values there is a clear separation
between the colors. Increase the parameter to smooth the transition and mix the colors.

Lightness (0-100). The parameter defines the number of light tones.
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Opacity = 40

 

Opacity = 75

 

Glow Spots = 0

 

Glow Spots = 90

 

Spot Size = 25

 

Spot Size = 60

Opacity (0-100). The parameter regulates the transparency of the aurora and visibility of the background. At value =
100, the glow is opaque. At lower values, it becomes lighter and weaker.

Glow Spots (0-100). The parameter adjusts the irregularity of brightness in different parts of the strip and adds bright
and dark spots. At low values, the glow looks more uniform.

Spot Size (10-100). The parameter changes the size of the bright areas in the glow.
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Blurring = 6

 

Blurring = 60

 

Height = 25

 

Height = 75

 

Uniformity = 10

 

Uniformity = 75

Blurring (0-100). The parameter lets stretching the glow spots in the horizontal direction making a uniform glowing
strip.

Shape Tab:

Height (10-100). The parameter sets the vertical size of the glow (in % of the image height).

Uniformity (0-100). The parameter changes the uniformity of the aurora's structure. At low values, the surface is
uneven. At high values, the glow looks smoother.

AKVIS NatureArt

70



 

Smooth Transition = 15

 

Smooth Transition = 80

 

Deformation = 0

 

Deformation = 65

Smooth Transition (10-100). The parameter adjusts the width of the transition zone at the edges of the effect area.
The lower the value, the clearer the edges are.

Deformation (0-100). The parameter adds random shifts and distortions to the aurora. Increasing the parameter can
attenuate the glow or move it beyond the boundaries of the image.
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NATURE EFFECTS: FIRE

The Fire effect adds flames to an image. You can create a realistic fire over an object or make a flaming text.

Note: The Fire effect is available for the Home Deluxe and Business licenses. In Home version, it can be applied
with a watermark. Compare the licenses.

 

Selection

 

Effect area

 
Fire Effect in AKVIS NatureArt

The effect is applied in a selected area and extends beyond it. Use the follow tools to make a selection:

Selection Brush . This tool is used to highlight areas to which an effect will be applied. You can change the tool's

size in a pop-up window which opens with a right mouse click in the image window.

To get a straight line, draw a line while holding down Shift .

Eraser . Use this tool to erase selection areas. You can change the tool's size in a pop-up window.

Selection Bucket . The tool fills an area outlined with the Selection Brush  (helpful for selecting large areas). If

the area was not circled by , the entire image will be selected by clicking with .

Hint: You can use Selection Bucket in "eraser mode" to erase all selections at the image. Just click the left
mouse button while pressing Ctrl .

Note: The selection indicates an approximate effect area. Sometimes it can be difficult to place a fire into a certain
area especially into a small area. When creating a selection take into account that the fire spreads from the center of
the selected area upward, left and right.
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Flames = 10

 

Flames = 130

 

Width = 5

 

Width = 50

 

Height = 40

 

Height = 250

 

The following parameters are available for this effect in the Settings Panel:

Flames (5-200). This parameter determines the number of basic components (flames) which make the fire.

Width (1-50). This parameter controls the width of the effect area. It determines the fire distribution within and
beyond the selection. It also influences the width of a flame tongue.

Height (1-250). This affects the height of the tongues of flame.

Blur (1-50). This controls the clarity of outlines of the tongues of flame. At higher values the softness of the edges as
well as the glow intensity increase.
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Blur = 5

 

Blur = 50

 

Distortion = 30

 

Distortion = 85

 

Transparency = 10

 

Transparency = 40

 

Color = -160 (cobalt blue flame)

 

Color = 0 (natural color of flame)

 

Color = 85 (chrome green flame)

Distortion (1-100). This parameter determines how curved the tongues of flame will be. The higher the value, the more
strongly the flame will be distorted, and the more changeable it will become.

Transparency (0-60). This parameter affects the translucency of the flame. At higher values, the color of the tongues
of flame fades and the image becomes visible through them.

Color (-180 to 180). You can change the color of the flame by using the gradient line or entering a value.
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NATURE EFFECTS: ICE

You can use the Ice effect to cover any surface in ice. It lets you freeze a lake or a pond even in summer, decorate your
Christmas pictures, create ice sculptures.

Note: The Ice effect is available for the Home Deluxe and Business licenses. In Home version, it can be applied
with a watermark. Compare the licenses.

 
Ice Effect in AKVIS NatureArt

The effect will be applied only in a selected area! Use the follow tools to make a selection:

Selection Brush . This tool is used to highlight areas to which an effect will be applied. You can change the tool's

size in a pop-up window which opens with a right mouse click in the image window.

To get a straight line, draw a line while holding down Shift .

Eraser . The tool lets you edit the selection. Adjust its size in a pop-up window.

Selection Bucket . The tool fills an area outlined with the Selection Brush  (helpful for selecting large areas).

If the area was not circled by , the entire image will be selected by clicking with .

Hint: You can use Selection Bucket in "eraser mode" to erase all selections at the image. Just click the left
mouse button while pressing Ctrl .

 

The effect configuration can be adjusted in the Settings Panel.

The main parameters:

Relief (0-100). Increasing this parameter makes the ice surface more uneven, with a sharper and deeper pattern.
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Relief = 20

 

Relief = 70

 

Illuminance = 20

 

Illuminance = 70

 

Glare = 0

 

Glare = 80

 

Transparency = 30

 

Transparency = 80

Illuminance (0-100). The parameter changes the brightness of light reflected from the ice. The higher the value, the
brighter the ice pattern and glare become. At lower values the brightness is less intense.

Glare (0-100). Increasing the value will result in a glare over an uneven surface. The higher the value of this
parameter, the brighter the glare. The number and the size of glare depend on the Illuminance. If Illuminance=0 the
glare is not visible.

Transparency (0-100). As this parameter is increased, the background becomes more visible. At lower values the ice
becomes more opaque and its color more evident.

Color. The ice color can be changed by clicking on the color plate and choosing a new color from the Select Color
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White Ice

 

Blue Ice

 

Density = 20

 

Density = 70

 

Max Length = 10

 

Max Length = 50

dialog.

There are two groups of the additional parameters which add more patterns to the ice's surface: Needles and Feathers.

Parameters under the Needles tab add a pattern of fine needles to the surface:

Density (0-100). Increasing the value increases the number of needles within the selected area.

Max Length (0-100). This parameter sets the maximum length of the needles. The length of needles may vary, but
they will not exceed the specified value.

Branching (0-100). As this parameter's value is increased, the needles begin to branch out and take the form of
crystalline branches. The higher the value the more branches will appear.
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Branching = 15

 

Branching = 45

 

Transparency = 10

 

Transparency = 70

 

White Needles

 

Blue Needles

Transparency (0-100). This parameter affects the transparency of the needles with respect to the background color.
At lower values the needles are more opaque; at higher values the background is more visible; and at 100% the needles
are completely transparent and invisible.

Color. The needles color can be changed by clicking on the color plate and choosing a new color from the Select Color
dialog.

Parameters in the Feathers tab can be used to add a pattern like icy feathers:

Density (0-100). This parameter increases the number of feathers on an image. At a value of 0 no feathers will be
present.
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Density = 20

 

Density = 90

 

Size = 10

 

Size = 30

 

Thickness = 25

 

Thickness = 75

 

Curvature = 0

 

Curvature = 50

Size (0-100). Increasing the value of this parameter makes feathers larger. They will increase in length as well as
width. If the value is set to 0 the feathers will disappear.

Thickness (0-100). If the value of this parameter is increased more branches will appear on the feathers. If the value
is set to zero the branches will disappear, and the feathers will take the form of thin rods.

Curvature (0-100). This parameter affects the degree to which feathers are curved. The higher the value the stronger
the curvature of the feathers will be. At a value of 0 the feathers will be straight.

Transparency (0-100). This parameter determines the translucence of the feathers. The higher the value, the more
the background is visible through the feathers. At the maximum value the feathers are completely transparent and
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Transparency = 0

 

Transparency = 90

 

White Feathers

 

Blue Feathers

invisible.

Color. The feathers color can be changed by clicking on the color plate and choosing a new color from the Select
Color dialog.
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NIGHT SKY

Mysterious and unexplorable, the night sky has fascinated humanity since time immemorial.

Using the Night Sky effect in NatureArt, you can imitate the beauty of the night sky on any image: add scattering stars,
iridescent nebulae, or impressive meteor showers.

Note: The Night Sky effect is available for the Home Deluxe and Business licenses. In Home version, it can be
applied with a watermark. Compare the licenses.

 
Night Sky Effect

The effect will be applied only in a selected area! Use the follow tools to make a selection:

Star Zone . Use this tool to mark areas where stars, meteors, or trails should appear. You can change the tool's

size in a pop-up window which opens with a right mouse click in the image window.
Nebula Zone . Use this tool to select the areas where the nebula should be added to the other objects. You can

change the tool's size in a pop-up window which opens with a right mouse click in the image window.
Eraser . Use this tool to erase selection areas. You can change the tool's size in a pop-up window.

Hint: To get a straight line, draw a line while holding down Shift .

 

In Settings Panel you can adjust the parameters for the Night Sky effect:

Common Parameters:

Base Color. This parameter sets the default color for all objects. Click on the plate to open the color selection dialog.
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Base Color = White

 

Base Color = Red

 

Fading = 25

 

Fading = 75

 

White Stars

 

Yellow Stars

Fading (0-100). When increasing the parameter, the brightness of stars, meteors, trails, and nebulae gradually
decreases at the bottom of the selection.

 

Select objects that will be displayed in the night sky by enabling the check-boxes: Stars, Meteors, Trails, and Nebulae.
Adjust their parameters in the appropriate tabs.

Stars

Color. Change the color of stars in the standard dialog by clicking on the color plate. If the color is not selected, the
Base Color will be used. Right-click to reset the color and clear the color plate.

Random Color (0-100). If the value of the parameter is zero, all stars have a specified color. When increasing the
parameter, the colors variety and saturation of random stars increase.
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Random Color = 10

 

Random Color = 60

 

Size = 25

 

Size = 75

 

Density = 10

 

Density = 50

Size (10-100). When increasing the parameter, the stars become larger. The size of stars will vary, but will not exceed
the specified value.

Density (1-100). The parameter increases the number of stars within the selected area.

Rays. If the check-box is enabled, the rays will be added to the stars whose size exceeds the Min Star Size value.
The rest of the stars will be displayed as bright dots.
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Check-Box is Disabled

 

Check-Box is Enabled

 

White Meteors

 

Blue Meteors

 

Random Color = 10

 

Random Color = 60

Random Seed. This is the starting number for the random number generator that defines the distribution of stars.

Meteors

Color. Change the color of shooting stars in the standard dialog by clicking on the color plate. If the color is not
selected, the Base Color will be used. Right-click to reset the color and clear the color plate.

Random Color (0-100). If the value of the parameter is zero, all meteors have a specified color. When increasing the
parameter, the colors variety and saturation of random meteors increase.

Size (0-100). The parameter increases the length and thickness of meteors. The size of meteors will vary, but will not
exceed the specified value.
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Size = 15

 

Size = 30

 

Elongation = -20

 

Elongation = 70

 

Density = 25

 

Density = 75

Elongation (-50..100). Increasing the parameter increases the length of meteor trails.

Density (0-100). The parameter increases the number of meteors in the selected area.

Angle (-180..180). The parameter sets the angle of incidence of meteors.
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Angle = -60

 

Angle = 110

 

White Trails

 

Orange Trails

 

Random Color = 20

 

Random Color = 70

Random Seed. This is the starting number for the random number generator that defines the distribution of meteors.

Trails

Color. Change the color of star trails in the standard dialog by clicking on the color plate. If the color is not selected,
the Base Color will be used. Right-click to reset the color and clear the color plate.

Random Color (0-100). If the value of the parameter is zero, all trails have a specified color. When increasing the
parameter, the colors variety and saturation of random trails increase.

Size (0-100). The parameter increases the length and thickness of trails. The size of trails will vary, but will not exceed
the specified value.
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Size = 10

 

Size = 100

 

Elongation = -25

 

Elongation = 25

 

Density = 10

 

Density = 50

Elongation (-50..100). Increasing the parameter increases the length of the star trails.

Density (1-100). The parameter increases the number of trails in the selected area.

Angle (-90..90). The parameter changes the angle of trails.
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Angle = -10

 

Angle = 30

 

White Nebula

 

Purple Nebula

 

Random Color = 20

 

Random Color = 70

Random Seed. This is the starting number for the random number generator that defines the distribution of trails.

Nebulae

Color. Change the color of nebulae in the standard dialog by clicking on the color plate. If the color is not selected, the
Base Color will be used. Right-click to reset the color and clear the color plate.

Random Color (0-100). If the value of the parameter is zero, the nebula has a specified color. When increasing the
parameter, the colors variety and saturation of certain nebula areas increase.

Density (0-100). The parameter specifies the number of areas forming the nebula.
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Density = 5

 

Density = 25

 

Brightness = 40

 

Brightness = 90

 

Size = 10

 

Size = 30

Brightness (1-100). At low values  ​​of the parameter, the nebula appears more transparent. Higher values increase its
brightness.

Size (0-100). When increasing the parameter, the size and blurriness of the nebula increases.

Deformation (0-100). The parameter determines the distortion of areas within the nebula.
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Deformation = 0

 

Deformation = 5

Random Seed. This is the starting number for the random number generator that defines the distribution of nucleus of
the nebula.
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SNOW

Snow is a fun part of the holiday season. A snowflake consists of the finest droplets of supercooled water that are frozen in
a cloud. The shape and size of snowflakes are determined on the conditions in which they formed. Each individual snowflake
has a different pattern and there are no two snowflakes alike.

Using the Snow effect in NatureArt, you can not only create realistic falling snow but also add decorative snowflakes to
images.

Note: The Snow effect is available for the Home Deluxe and Business licenses. In Home version, it can be applied
with a watermark. Compare the licenses.

By default, the effect is applied to the entire image.

The Exclusion Area tool  allows marking those parts of the image that should be partially or completely excluded from

the effect area.

Tool Parameters:

- Brush Size (1-1000). The parameter defines the tool's diameter.

- Hardness (0-100%). The degree of blurriness of the outer edge. The higher the value of this parameter, the harder
the edge of the brush becomes.

- Strength (1-100%). The amount of influence on an image.

The Eraser tool  allows you to edit the excluded area.
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Full Processing

 
Exclusion Area

 
Partial Processing

Check-Box Disabled Check-Box Enabled

Size = 20 Size = 30

Hint: You can achieve a similar result with the History Brush , which allows you to restore the image to its original

state.

 

Adjust the effect parameters in the Settings Panel:

The check-box Apply Effect shows/hides the snow effect.

Snow Tab

Size (20-30). The size of the snowflakes.

Density (80-120). The number of falling snowflakes.
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Density = 80 Density = 100

Small Snowflakes = 60 Small Snowflakes = 100

Medium Snowflakes = 60 Medium Snowflakes = 100

Large Snowflakes = 60 Large Snowflakes = 100

Small Snowflakes (0-100). The opacity of small snowflakes.

Medium Snowflakes (0-100). The opacity of medium snowflakes.

Large Snowflakes (0-100). The opacity of large snowflakes.

Angle (0-180). The direction of snowfall (in degrees, measured clockwise from the horizontal axis).
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Angle = 70 Angle = 180

No Fog Effect (Check-Box Disabled) Fog Effect Applied (Check-Box Enabled)

Lighten = 0 Lighten = 80

Opacity = 0 Opacity = 60

Extra Tab

You can enable the group of parameters Fog by activating the check-box.

Lighten (0-80). The amount of white fog at the top of the image.

Opacity (0-80). The intensity of haze.

Density (50-100). The density of clumps of fog.
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Density = 50 Density = 90

Desaturation = 10 Desaturation = 90

Strength = 10 Strength = 80

Reveal Original Colors = 0 Reveal Original Colors = 70

 

The group of parameters Colorizing changes the color temperature of the image making it cooler (bluer).

Desaturation (0-100). The parameter reduces the color saturation.

Strength (0-100). The parameter sets the intensity of toning.

Reveal Original Colors (0-70). The parameter restores the original colors at the bottom of the image.

The Random Seed button generates another distribution of the snowflakes in the image.
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White Snowflakes Pink Snowflakes

The Snow Brush tool  allows creating decorative snowflakes. The hot-key is B . You can either supplement the main

effect or use decorative snowflakes separately by disabling the Apply Effect check-box.

Note: You can only draw with the Snow Brush  in the After tab!

 

Using Snow Brush

Snow Brush Parameters

Right-click within the image to show the pop-up dialog with the general brush options:

Brush Size (50-1000). The parameter defines the tool's diameter.
Filling Density (1-100). The number of snowflakes created with the brush.
Opacity (1-100). The parameter defines the transparency of the snowflakes. At value 100%, the snowflake is opaque.

Snowflake Properties

Before drawing snowflakes, adjust their parameters in the Settings Panel -> Snow Brush. The Snow Brush tab includes
three groups of settings: Snowflakes, Structure, and Variations.

The Snowflakes tab allows you to change the basic properties of the snowflakes.

Color. You can change the color of the snowflakes by clicking on the color plate and selecting a new color in the
standard dialog.

Size (15-150). The parameter adjusts the primary size of the snowflakes.
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Size = 20 Size = 100

Rotation = 0 Rotation = 10, 20, 30

No Icing (Check-Box Disabled) Icing (Check-Box Enabled)

Intensity = 10 Intensity = 100

Rotation (-90..90). This parameter defines the angle of rotation for all the snowflakes.

Icing. Enable the check-box to add an icy pattern to the snowflakes. You can adjust the Intensity and Smoothing of
icing.

Intensity (10-200). The amount of ice that is added to the snowflakes.

Smoothing. The check-box enables blurring of the ice pattern.
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No Smoothing (Check-Box Disabled) Ice Pattern Smoothing (Check-Box Enabled)

Edges Sidebranches

Identical Shape (Check-Box Disabled) Random Shape (Check-Box Enabled)

The Structure tab contains the snowflake shape constructor.

A snowflake is a stellar crystal with six branches called the dendrites. On the dendrites, there are Edges and
Sidebranches. These elements can be attached on different levels. You can change the number of levels from 1 to 4.
Each level displays the items for which a check-box is enabled. The length of the sidebranches can be adjusted using
the sliders.

Enable the Random Shape check-box to generate randomly shaped snowflakes.

Shift from Center. The parameter allows you to shift the elements to the outer edge of the snowflake.
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Shift from Center = 0 Shift from Center = 100

White Snowflakes Color Variations = 40

Size = 100 Size Variations = 90

Rotation = 20 Rotation Variations = 30

The Variations tab regulates parameter deviations and allows you to add random effects to the snowflakes.

Color Variations (0-60). The parameter changes variations of the primary color. Increasing the value increases the
diversity of snowflakes colors.

Size Variations (0-100). The parameter specifies the difference between the size of snowflakes. If the value is zero,
all the snowflakes have the same size. Increasing the value increases the range of the sizes.

Rotation Variations (0-90). The parameter specifies variations of snowflakes' rotation.

Tilt Variations (0-80). The parameter sets the difference in the inclination of snowflakes.
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No Tilt Variations Tilt Variations = 80

No Blur Variations Blur Variations = 100

No Opacity Variations Opacity Variations = 90

Blur Variations (0-100). The parameter specifies the difference in the clarity of snowflakes.

Opacity Variations (0-90). The parameter adjusts the difference in the transparency of snowflakes.
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TORCH OF LIBERTY

In this tutorial we apply the Fire effect. We use a photo of the world's most famous statue – The Statue of Liberty, and
make her torch burn with this flame.

Original Image Result

and make her torch burn with this flame.

Step 1. Open the standalone version of AKVIS NatureArt. Open the image of the statue by pressing .

Step 2. Choose the Fire effect from the list.

First, select the area which will "burn" with the  and  tools.

Step 3. Press  to begin processing using the default settings (AKVIS Default). The result will be shown in the

After tab.
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Change the settings (we use AKVIS Twister preset):

Step 4. Press  to process the image with the changed parameters.

Here is the result:

Click on the image to enlarge

Now just save the result by pressing .
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NATUREART GALLERY

Nature is full of beauty and danger, surprises and gifts, grandeur and magic. With AKVIS NatureArt you can create both fun
and dramatic photos with a mouse click! Look at the pictures made with the program. Do you wish to share your experience?
Please send us your results to info@akvis.com.

 

Flooded Ruins (Water effect)

(open a larger version)

 

Thunderer (Clouds and Lightning effects)

(open a larger version)
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Snow Storm (Clouds and Rain effects)

(open a larger version)

 

Starry Sky (Night Sky and Sun effects)

(open a larger version)

 

Ancient Castle (Rain and Lightning effects)
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(open a larger version)
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Melting Ice (Ice effect)

(open a larger version)

 

Walking on a Rainbow (Sun, Clouds, and Rainbow effects)
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(open a larger version)
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Winter in the Desert (Rain, Frost, Clouds, and Sun effects)

(open a larger version)

Superabilities (Rainbow, Sun, Fire, Lightning, and Water effects)

(open a larger version)
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Fire-Breathing Dragon (Fire effect)

(open a larger version)
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Dreams of Love (Clouds effects)

(open a larger version)

 

Faerie Fire (Fire effect)
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(open a larger version)
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Christmas Card (Aurora effect)

(open a larger version)

 

AKVIS PROGRAMS
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AKVIS PROGRAMS

 

AKVIS AirBrush — Airbrushing Techniques on Your Photos

AKVIS AirBrush automatically transforms a photograph into a work of art which looks like made with a special airbrush tool
that sprays paints or inks. The software works as an artistic filter creating stylish colorful airbrush designs from images using
chosen settings of photo-to-painting conversion. More…

 

AKVIS Artifact Remover AI — JPEG-Compressed Image Restoration

AKVIS Artifact Remover AI uses artificial intelligence algorithms to remove JPEG compression artifacts and restore the
quality of compressed images. This program provides 4 image enhancement modes, each involves a unique neural network
developed especially for this occasion. The software is available free of charge for home users. For commercial use, a
Business license is offered. More…

 

AKVIS ArtSuite — Frames and Effects for Your Photos

AKVIS ArtSuite is an impressive collection of versatile frames and effects for photos. ArtSuite contains many templates and
texture samples that can be used to create a virtually limitless variety of options for generating frames.
Decorate a photo to give it an original and festive look! More…
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AKVIS ArtWork — Collection of Painting & Drawing Techniques

AKVIS ArtWork is photo to painting software designed to imitate different artistic techniques: Oil Painting, Watercolor,
Gouache, Comics, Pen & Ink, Linocut, Stencil, Pastel, and Pointillism. ArtWork helps you to create a piece of art out of any
picture! More…

 

AKVIS Chameleon — Photo Collage Creation

AKVIS Chameleon is a fun to use tool for photo collage creation. It makes the process easy and entertaining. The tool is
very easy to handle as it does not require precise selection of objects.
Using the software you can quickly create your own photo collages. More…
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AKVIS Charcoal — Charcoal & Chalk Drawings

AKVIS Charcoal is a creative tool for conversion of photos into charcoal and chalk drawings. Using the program you can
make professional-looking expressive black and white images. Playing with colors and options you can achieve outstanding
artistic effects, such as sanguine and others. More…

 

AKVIS Coloriage — Add Color to Black and White Photos

AKVIS Coloriage allows colorizing B&W photos and replacing colors in color images, performing selective colorization and
desaturation. It helps to breathe new life into your old family photographs, bring a vintage or artistic appearance to your
digital images. More…

 

AKVIS Decorator — Resurface and Recolor

AKVIS Decorator lets you change the surface of an object in a realistic manner. The program puts on a texture keeping the
volume of an object, following its folds and creases. The new pattern looks absolutely natural and makes you see things
differently. Recoloring is also made easy. More…
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AKVIS Draw — Hand-made Pencil Drawing Effect

AKVIS Draw converts your photos into hand made pencil drawings. The software creates realistic looking line art illustrations,
produces both B&W and color drawings. Add a hand-drawn look to your pictures! More…

 

AKVIS Enhancer — Bring Detail To Your Pictures

AKVIS Enhancer is image enhancement software that detects detail in underexposed, overexposed and mid tone areas of a
photo with uneven exposure. Enhancer improves every part of the image! The software works in three modes: Improve
Detail, Prepress, and Tone Correction. The program offers a fast method to fix a dark photo, add contrast and brightness to
a picture, it lets you improve color and adjust tones. More…

 

AKVIS Explosion — Fabulous Particle Explosion Effects

AKVIS Explosion offers creative destruction and particle explosion effects for your photos. It bursts an object and applies
dust and sand particles to an image. With the software, you can create eye-catching graphics in just a few minutes! More…
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AKVIS Frames — Decorate Your Photos with Frames

AKVIS Frames is a free program designed for working with the AKVIS frame packs

 

AKVIS HDRFactory — High Dynamic Range Images: Brighter than Reality!

AKVIS HDRFactory lets you create a High Dynamic Range image from a series of shots or from one single photo. The
program can also be used for photo correction. The program brings life and color to your photos! More…

 

AKVIS Inspire AI — Artistic Stylization of Images

AKVIS Inspire AI stylizes images using various samples of painting. The AI-based program applies the color scheme and style
of a selected artwork to a photo creating a new masterpiece. The software includes a gallery of art styles and allows to load
a custom sample. Imitate the style of world famous artists! More…
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AKVIS LightShop — Light and Star Effects

AKVIS LightShop lets you create an infinite number of astounding light effects! The program offers advanced lighting
techniques for adding stars and glow effects to images. A light effect draws attention and brighten up any photo. Add a little
magic to your pictures! More…

 

AKVIS Magnifier AI — Enlarge Images & Enhance Quality

AKVIS Magnifier AI allows you to increase the size of photos and improve image quality and appearance. Featuring neural
network-based algorithms, Magnifier AI upscales images to super-high resolution, up to 800%, and produces wall-sized prints.
Improve image resolution, create clear, detailed images with perfect quality! More…

 

AKVIS MakeUp — Retouch Your Portrait Photos!

AKVIS MakeUp improves your portraits giving them a professional look. The software retouches facial imperfections making
your skin radiant, beautiful, pure and even. The program adds glamour to your pictures and creates a high key effect. Look
your best in every photo with AKVIS MakeUp! More…
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AKVIS NatureArt — Bring Nature to Your Photos

AKVIS NatureArt is an excellent tool for imitating the magnificence of natural phenomena on your photos. The program
includes a number of effects: Rain

 

AKVIS Neon — Glowing Drawings from Photos

AKVIS Neon lets you create amazing glowing lines effects. The software transforms a photo into a neon image that looks like
drawn with luminescent ink. More…
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AKVIS Noise Buster AI — Digital Noise Reduction

AKVIS Noise Buster AI is software for noise suppression on digital and scanned images. The program is efficient for removing
any type of digital noise. It reduces both luminance and color noise without spoiling other aspects of photos. The software
includes AI technologies and adjustments for manual refining. More…

 

AKVIS OilPaint — Oil Painting Effect

AKVIS OilPaint turns your photos into oil paintings. The mysterious production of a painting happens right before your eyes.
The unique algorithm authentically reproduces the technique of the real brush. With this cutting-edge software you can
become a painter! More…

 

AKVIS Pastel — Turn Photos into Pastel Paintings

AKVIS Pastel turns your photos into pastel paintings. The program converts your photo into a lifelike digital art imitating one
of the most popular artistic techniques. AKVIS Pastel is a powerful tool to unleash your creativity! More…
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AKVIS Points — Apply Pointillism Effect to Your Photos

AKVIS Points lets you transform your photos into paintings using one of the most exciting artistic techniques - pointillism.
With the software you can easily create gorgeous works of art in a pointillist manner. Discover the world of bright colors!
More…

 

AKVIS Refocus AI — Focus Improvement & Blur Effects

AKVIS Refocus AI improves the sharpness of out-of-focus and blurry photos, enhances the entire image or partially, creating
a selectively focused area. It's also possible to add bokeh and lens blur effects to your photos. The program provides five
image processing modes: Refocus AI, Tilt-Shift, Iris Blur, Motion Blur, and Radial Blur. More…

 

AKVIS Retoucher — Image Restoration Software

AKVIS Retoucher is an efficient program for photo restoration and photo retouching. The software removes dust, scratches,
stains, and other defects that appear on damaged photos. It intelligently reconstructs the missing parts of the photo using
the information of the surrounding areas. More…
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AKVIS Sketch — Turn Your Photos into Pencil Sketches

AKVIS Sketch converts photos into amazing pencil drawings. The software creates realistic color artworks and B&W
sketches, imitating the technique of graphite and color pencil. The program offers these photo to drawing conversion styles:
Classic, Artistic, Maestro, and Multistyle, - each with a series of presets. AKVIS Sketch allows you to feel like a real artist!
More…

 

AKVIS SmartMask — Save Time on Complex Selections!

AKVIS SmartMask is an efficient selection tool that saves time and is fun to use. Selection has never been so simple! The
software considerably increases your productivity. You will be freed from boring work and will have more room for creativity
and realization of your ideas. More…
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AKVIS Watercolor — Aquarelle Art from Photos

AKVIS Watercolor easily makes a photo look like a brilliant and vibrant watercolor painting. The program includes two styles
of photo to painting conversion: Classic Watercolor and Contour Watercolor; each comes with a wide range of ready-to-use
presets. The software turns ordinary images into aquarelle pieces of art. More…
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